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Overview 
The views feature of ImageNow includes the View Designer. This guide introduces and explains how to 
set up and use views so that you can quickly start working with them. The guide is divided into four 
sections. 

• The first section introduces the views feature to the ImageNow owner and managers and to 
ImageNow and WebNow Client users. 

• The second section, of interest primarily to the owner and managers, explains how to use View 
Designer to set up view definitions and perform related tasks that are accessible only to a person with 
manage privileges. 

• The third section, of interest primarily to ImageNow and WebNow Client users, explains how to find 
documents and projects using the view and filter concepts as well as how to narrow the results of the 
views or filters provided by your managers.  

• The reference section contains tables of toolbars, toolbar buttons, and a detailed explanation of view 
conditions and the use of variables in conditions. 

More specialized topics on working with views appear on the Perceptive Software website, in the 
Customer Portal, under Product Documentation. 

Welcome to ImageNow Views 
In this section, you’ll learn the features and benefits of views, the different types of views, and the 
differences between a view and a view definition. You’ll also find answers to the questions most 
commonly asked about the views feature by users of previous versions of ImageNow. 

What is a view? 
In ImageNow, a view is a set of documents, projects, tasks, or workflow items selected according to a 
view definition created by a view manager for ImageNow and WebNow Client users. As of ImageNow 6.2, 
views replaced and greatly enhanced the saved queries feature of previous versions. A user can still 
achieve the function of saved queries from previous versions of ImageNow by creating private filters. For 
more information, refer to the “Filters” section of this document. 

Views provide three principal advantages: 

• Simplification - Views are a convenience because they can display just the documents users need 
to work with, while at the same time preventing the display of dozens, hundreds, or even thousands 
of documents that might otherwise clutter the ImageNow Explorer search results grid. 

• Preformatting of Columns and Rows - Views are preset to display only the columns that users 
need to see or work with, including custom property columns. In the view definition, you can preset 
column names to give meaningful labels to each data field as well as accommodate length of the data 
values by presetting column width. In the view definition, you can also predefine sort order and 
grouping of rows of documents or projects. 

• Heightened Search Security - Views add another layer of protection to the documents stored in 
ImageNow Server, in addition to drawer privileges. A view allows selective searching of documents 
such that users can see just the documents that satisfy the conditions of the view definition. 

Users can double-click a row in a view, assuming they have the appropriate View privileges, to display a 
document image, the contents of a project, the document and project tasks, or workflow items. The 
following figure shows the Views pane of the ImageNow Explorer or WebNow Explorer. Views are shown 
under Documents, Projects, Tasks, and Workflow. 
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In a document view type, the Views 
pane shows the views and filters that 
display a list of documents that satisfy 
the conditions in the view definition. 

 

In a project view type, the Views pane 
shows the views and filters that display 
a list of projects that satisfy the 
conditions in the view definition. 

In a task view type, the Views pane 
shows nine automatic lists of tasks and 
their filters that display a list of tasls that 
satisfy the task rules. 

In a workflow view type, the Views pane 
shows a list of processes and queues 
the user can access that display the 
workflow items in the process and 
queue. 
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View roles 
The following table outlines the different roles users can have with views. 

ImageNow role Role function Global Privileges View Privileges 

ImageNow owner or 
manager 

Create or modify any 
view and grant view 
management privileges. 

Owner or manager n/a 

Document view manager Create, modify, and 
grant access to 
document view 
definitions. 

Manage Document 
Views 

Access, Manage 

Project view manager Create, modify, and 
grant access to project 
view definitions. 

Manage Project Views Access, Manage 

Task view manager Create, modify, and 
grant access to task 
view definitions 

Manage Task Views Access, Manage 

View user Run and create filters for 
accessible views  

Search privilege for 
applicable drawers 

Access, Access by 
URL, Filter 

Views and view definitions 
In ImageNow View Designer, view managers create view definitions that generate views in ImageNow 
and WebNow. A view definition contains conditions that narrow the scope of documents that can appear 
in the view. A view, on the other hand, contains documents or projects or tasks. For example, a view 
definition can cause ImageNow to return all documents that have been assigned to the Accounts Payable 
drawer with a Waiver custom property value of Approved or an Amount custom property value of less 
than $40.00. 

The results of a view can change even if the view definition that generated it remains the same. For 
example, the contents of a view can change if:  

• A user adds documents or projects to ImageNow that satisfy the conditions of the view definition.  

• A user removes documents or projects that were originally displayed in the view.  

• A user completes a list of tasks or routes a list of items to another workflow queue. 

• Values of index keys or custom properties of a document in a view are changed by the user or by an 
iScript such that the document no longer satisfies the conditions of the view definition. 

• The view definition contains variables (user or date and time) in one or more of its conditions. Results 
can then depend on either which user is running the view, or on the date and time the view is run, or 
on both variable values. 
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Manual run views and automatic views 
Document, project, task, and workflow views are classified by the way users run them. The following list 
describes the two methods in which you run views: 

• The manual  icon usually indicates that a very large number of documents is expected to be 
returned, so the user is given a chance to enter additional search criteria, or select a filter, before 
clicking the Go button. 

• The automatic  icon indicates a view that displays its results as soon as the user clicks it in the 
Views pane. You typically use an auto run view to return a small number of rows, when it is less 
important to apply a filter to the results before displaying them. 

The following figure shows a manual run document and an auto run document in the Documents node of 
the Views pane of ImageNow or WebNow Explorer. 

 

Document views 
Users with the Manage Document Views privilege can create view definitions for documents. After the 
document view manager creates the view, the view appears in the Documents drop-down menu on the 
ImageNow toolbar, and the view and its public filters appear in the Views pane of ImageNow or WebNow 
explorer. Two document views exist by default for all users: 

• All Documents: This manual run view returns all documents the user can access. 

• My Recycled Documents: This automatic view returns all documents the user deleted. 

Project views 
Users with the Manage Project Views privilege can create view definitions for projects. After the view 
manager creates the view, the view appears in the Projects drop-down menu on the ImageNow toolbar, 
and the view and its public filters appear in the Views pane of ImageNow or WebNow Explorer. Two 
project views exist by default for all users: 

• All Projects: This manual run view returns all projects the user can access. 

• My Recycled Projects: This automatic view returns all projects the user deleted. 

Task views 
Users with the Manage Task Views privilege can modify the column layout, but not the conditions, of the 
following system view definitions, available by default to all users: 

• All Tasks: This manual run view displays all tasks the user can access. 

• My Assigned: This automatic view displays all the incomplete tasks to which the user is assigned. 

• To Review: This automatic view displays all the incomplete tasks the user needs to review. 

• Returned to Me: This automatic view displays all the tasks that were returned to the user. 

• Complete Pending Review: This automatic view displays all tasks in a complete pending review 
state for which the user has necessary privileges. 
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• Returned by Me: This automatic view displays all tasks the user returned. 

• Complete: This manual run view displays all tasks in a complete state for which the user has the 
necessary privileges. 

• Canceled: This manual run view displays all tasks in a canceled state for which the user has the 
necessary privileges. 

• Invalid: This manual run view displays all tasks in an invalid state for which the user has the 
necessary privileges. 

Task view managers can also add public filters to these system views. These views appear in the Tasks 
drop-down menu on the ImageNow toolbar, and the views and their public filters appear in the Views  
pane of ImageNow or WebNow Explorer.  

Workflow views 
Workflow views appear automatically for each workflow process and queue the user can access. View 
managers cannot modify these views or create additional workflow view definitions. Each workflow 
process appears in the Workflow drop-down menu on the ImageNow toolbar and appears as a manual 
run view in ImageNow or WebNow Explorer. Each workflow queue appears in the menu for the 
associated workflow process in the Workflow drop-down menu on the ImageNow toolbar and appears as 
an automatic view in ImageNow or WebNow Explorer. Complete queues appear as manual run views. 

View definition components 
All view definitions can contain any or all of the following components. 

Conditions 
You build document, project, task, and workflow views using conditions. Views can include multiple 
conditions or groups of conditions, which consist of a search constraint, a search type, a field, an 
operator, and a value. In View Designer, on the Views tab, conditions and groups of conditions are 
displayed as rows. 

A condition acts like a true-or-false question. If the answer to the condition is true, the document is 
returned in the ImageNow or WebNow Explorer results grid when you click the Go  button. If the 
answer to the condition is false, the document does not appear. To learn more about how ImageNow 
applies conditions and how to arrange the grouping of conditions, refer to the "Grouping and ordering 
evaluation of conditions” topic in ImageNow User Help. 

Refer to the “Define the conditions for the view” section in this document for details on defining conditions 
for a view. 

Column layout 
You can define column layout, sorting, and appearance for the view or one of its public filters. When 
defining column layout, you can reorder, rename, hide, and show columns within the search results grid. 
You can also add one or more custom property columns and group and sort the view results. Refer to 
“Customize the view column layout” section in this document for details on working with your column 
layout. 

Public filters 
In ImageNow View Designer, a filter is an optional part of a view definition that narrows the results 
returned by the view. When you create a filter in View Designer, that filter becomes available to all users 
with access to the corresponding view. It is called a public filter. Each public filter associated with the view 
can have its own conditions, column layout, and statistics. Refer to the “Defining public filters for views” 
section of this document for details on creating public filters. 
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Statistics 
Any view definition can include calculated statistics of columns. If your view includes statistics, they 
appear below the search grid. When you click the Select in grid  button for a statistic, the Explorer 
highlights documents in the search grid that correspond to the function, such as Maximum or Mode value, 
that generated the statistic. If an Open  button appears for a statistic, you can click it to open the 
corresponding document or project in ImageNow, WebNow, or Project Viewer. Refer to the “Adding 
statistics to views” section of this document for details on creating statistics. 

Security 
View managers can determine which users can access, create filters for, and manage specific document, 
project, and task views. Refer to the “Defining view and filter security” section of this document for more 
information about setting view security. 

Frequently asked questions 
The following questions and answers address the most common concerns of users familiar with previous 
versions of ImageNow. 

Question Answer 

Can a view manager create a view definition that 
shows all the documents, projects, or tasks in 
ImageNow? 

Yes. When ImageNow is installed, default views 
are already in place to do this: All Documents, All 
Projects, and All Tasks. An owner or manager can 
modify or remove these views. Users of the views 
still see only documents in drawers for which they 
have the Search privilege or project types for which 
they have the Use privilege. 

Can a view manager limit access to a view by user 
or group? 

Yes, a view manager can allow users and groups 
to see the contents of a view. A view manager can 
also selectively grant the ability to save private 
filters and edit the view definition. 

Can a user further limit the number of items 
displayed in a view? 

Yes, using either the Search or Quick Search tab. If 
the user has the Filter privilege, he can also save 
his search criteria in a private filter. A filter 
resembles the saved query of previous versions of 
ImageNow, but a filter can also save information for 
column width, name, arrangement, sorting, and 
grouping. 

Can a user still save a query? Yes. If the user has the Filter privilege for a view, 
he can save the conditions from the Search or 
Quick Search tab as a private filter. 

Can a user display items that don't satisfy the 
conditions of a view definition? 

No. No searching technique can display more 
documents or projects than the view was originally 
defined to display. However, if a view manager 
grants the Manage privilege to a user for the 
specified view, as well as the global Manage View 
privilege, the user can then change the view 
definition to return more or different documents, 
projects, or tasks. 
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Question Answer 

What happens if a view includes documents in 
drawers for which the user does not have access 
privileges? 

Those documents do not appear in any of the 
views granted to the user. 

Can a view manager create filters that can be 
applied by any user who can see the associated 
view? 

Yes, using public filters. The view manager can 
define a public filter independently or publish a 
user's private filter so that it becomes public. The 
view manager can view and publish any private 
filter in View Designer. 

Does ImageNow automatically refresh the view grid 
whenever a change occurs to any of the 
documents in the view? 

If the user changes the document, the search 
results grid refreshes automatically. Your 
ImageNow administrator can also configure 
automatic refresh settings in ImageNow.ini file. 
Otherwise, ImageNow does not refresh the grid. 

Can a view manager create additional task views? No. The view manager can only modify the column 
layout and public filters of the nine system task 
view definitions. 

Can a view manager create additional workflow 
views? 

No. Workflow views appear automatically based on 
the user’s workflow process and queue privileges. 
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View security for ImageNow owners or managers 
In this section, you’ll learn how to grant view management privileges if your ImageNow security profile 
includes one of the following: 

• ImageNow owner 

• ImageNow manager 

• User with global Manage User Security privilege 

View management privilege definitions 
Users with specific view management privileges can perform the actions outlined in the following table. 

Privilege Description Privilege Location 

Manage Document Views The user or group can create 
new document views and copy 
existing document views for 
which the user has the Access 
privilege. The user or group can 
modify any document views for 
which the user or group has the 
Manage privilege. 

This privilege is located in 
ImageNow Management 
Console, on the Global Privileges 
tab, under Manage. 

Manage Project Views The user or group can create 
new project views and copy 
existing project views for which 
the user has the Access 
privilege. The user or group can 
modify any project views for 
which the user or group has the 
Manage privilege. 

This privilege is located in 
ImageNow Management 
Console, on the Global Privileges 
tab, under Manage. 

Manage Task Views The user or group can define 
public filters and customize the 
column layout of a system task 
view for which the user or group 
has the Manage privilege. 

This privilege is located in 
ImageNow Management 
Console, on the Global Privileges 
tab, under Manage. 

Manage The user can modify the view. 
This privilege requires the global 
privilege for the view type. 

This privilege is located in 
ImageNow View Designer, in the 
View Properties dialog box, on 
the Security tab. 

Grant view management privileges 
ImageNow owners, managers, or users with management privileges can grant view management 
privileges to users and groups. 

1. Open ImageNow Management Console and, in the left pane, select one of the following options: 

• To grant view management privileges to a user, click Users. 

• To grant view management privileges to a group, click Groups. 

2. In the right pane, on the Security tab, search for and select the user or group and then click Modify. 
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3. In the Security Settings dialog box, on the Global Privileges tab, under Manage, grant the 
Document Views, Project Views, or Task Views privilege by clicking the column in front of the 
privilege until the Grant  icon appears. 

4. Click OK and then click Close. 
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Views for view managers 
In this section, you’ll learn how to create a document or project view definition in ImageNow View 
Designer by completing the following actions: 

• Defining conditions for the view definition 

• Adding public filters to the view 

• Customizing the column layout of the view 

• Adding statistics to the view 

• Defining user access to the view 

Getting started with ImageNow View Designer 
ImageNow View Designer enables you, as a view manager, to create and manage view definitions. In it 
you can set up the conditions, column formatting, and user access that give views their power, versatility, 
and convenience. You can define public filters, which act as special-purpose refinements of a view, and 
you can inspect any private filters created by the persons who use your view definitions on a daily basis. 
You can also make private filters available to all users of the corresponding view by publishing them. 

About the View Designer Interface 
ImageNow View Designer is divided into three functional areas. 

The View tab lets you create the conditions, or rules that control which documents are returned by the 
view definition. In this tab, you add or modify the conditions that a document or project must satisfy to 
appear in the search results of the view. 
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The Filter tab lets you create public filters that return subsets of results for the view, and it lets you 
manage the private filters created by view users. 

 

The Preview pane allows you to sample the results of your view, rearrange the columns, add statistics, 
add new columns for custom properties, define sort order of rows, group the resulting rows by any column 
heading, and create preview variables to determine what the results of the view will look like for your view 
users. For more information about creating preview variables, refer to the “Enabling the view in 
ImageNow and WebNow Explorer” section in this document. 
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Create a new view definition 
Before a view manager can perform this procedure, he or she must have one of the following global 
privileges: 

• Manage Document Views 

• Manage Project Views 

View managers cannot create new task view definitions. 

1. Open ImageNow Management Console and then, in the left pane, click Views. 

2. In the right pane, do one of the following options: 

• To create a new document view, click the Documents tab. 

• To create a new project view, click the Projects tab. 

3. Click New. 

4. In the New View dialog box, in the Name box, type a name and, in the Description box, type the 
description of the view that appears in the ToolTip for the view. 

5. Click OK and, with the new view selected, click Modify to open View Designer. 

Define the conditions for the view 
To review the use of conditions and the definitions of the conditions available for documents, projects, 
tasks, and workflow items, refer to the topics in the “Work with Conditions” section in ImageNow User 
Help. 

1. With the view open in ImageNow View Designer, on the View tab, click the Add  button. 

2. In the Add Condition dialog box, in the Constrain by list, click the view constraint to use. 

3. In the Type list, select the type of search to perform.  

4. In the Field list, select the field to use in the search. 

5. In the Operator list, select an operator to use when comparing the field and the value. 

6. If you are performing a LearnMode search, in the Plan list, select an application plan. 

7. In the Value box, select or type a value for the search. 

Note  If you selected Prompted in the Type list, the Message box appears instead. Enter instructions 
indicating what value to enter.  

8. Click OK. 

9. To add another condition to the view, repeat the previous steps. 

Note  When you define a search with multiple conditions, each new row begins with AND by default. 
To change AND to OR, click AND. 

Rearrange the view conditions 
After you create all the search conditions you want to define for the view, you can reorder them in 
ImageNow View Designer. 

1. To select the condition you want to reorder, in View Designer, on the View tab, complete the following 
substeps: 

1. Position your mouse cursor over the condition you want to select so that a blue arrow appears in 
the pane to the left of the condition. 

2. In the pane to the left of the condition, click the blue arrow. 
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2. To order the condition, do one of the following options: 

• To move the condition up one position, click the Move Up  button. 

• To move the condition down one position, click the Move Down  button. 

Group the view conditions 
If your view contains two conditions you want to evaluate simultaneously, you can group them in 
ImageNow View Designer. To review how ImageNow evaluates grouped and ungrouped conditions, refer 
to the “Grouping and ordering evaluation of conditions” topic in ImageNow User Help. 

1. To select the condition you want to reorder, in View Designer, on the View tab, complete the following 
substeps: 

1. Position your mouse cursor over the condition you want to select so that a blue arrow appears in 
the pane to the left of the condition. 

2. In the pane to the left of the condition, click the blue arrow. 

3. Hold down the CTRL key, and then repeat the previous steps to select the second condition. 

2. In the toolbar, click the Group  button. 

3. Optional. To change the group operator from AND to OR or from OR to AND, click the operator inside 
the parentheses. 

Define the view run mode 
The view manager can determine whether a view the user accesses in ImageNow or WebNow Explorer 
runs as soon as he or she clicks the icon in the Views pane or runs after the user defines additional 
criteria. 

If a view might generate a large number of results, the user typically prefers to limit the number of rows 
returned by defining additional search criteria or by running a public or private filter under the view name. 
In this case, a manual run view is preferable. 

1. In View Designer, on the View tab, click the Properties  button. 

2. In the View Properties dialog box, on the General tab, do one of the following actions: 

• To automatically display the view results when the user selects the view in ImageNow or 
WebNow Explorer, select the Automatically run this view check box. 

• To require the user to define additional search criteria or click the Go button before displaying the 
view results, clear the Automatically run this view check box. 

3. Click OK. 
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Defining public filters for views 
View managers can add public filters to a view definition. When you add a public filter, the filter contains 
all the search conditions defined for the view and allows you to define additional conditions that can return 
a subset of the view data. Public filters can be active (visible to users) or inactive (hidden from users even 
when the view itself is active).  

Filters are unlike views in two ways:  

• When the user clicks a filter, the results are always displayed immediately. There is no need to click 
the Go  button. 

• When the user clicks a filter (and the view manager included the prompting feature in the filter 
definition), the filter can prompt the user to select or enter values before it generates the result set. In 
this way, the user's values become part of a condition in the filter. 

When the view manager creates a filter in View Designer, that filter becomes available to all users with 
access to the corresponding view. This type of filter is called a public filter . When a user creates and 
saves a filter, it is available only to that user and is called a private filter . View managers can also 
evaluate the private filters users created for the view and modify them to become public filters. Changing 
a private filter to a public filter is called publishing. 

View definitions vs. public filters 
Although there is no absolute rule to determine when you should create a new view definition, as 
opposed to creating a filter in an existing view definition, the following guidelines will help in your 
planning. 

Situation Recommendation 

Conditions in existing view definitions exclude any of the documents or 
projects you need to display. 

Create a new view 
definition 

The documents or projects returned by a view definition should be seen by 
users who are different from those who have access to existing views. 

Create a new view 
definition 

The view definition by itself returns more documents, projects, or tasks than 
the user wants to see all at once. 

Create one or more 
public filters 

You want to securely determine who can view the results of a view. Create a new view 
definition 

You want to define search criteria for a task view that differs from the 
conditions in a system view.  

Create one or more 
public filters 

Add a public filter to a view 
Before a view manager can perform this procedure, he or she must have one of the following global 
privileges: 

• Manage Document Views 

• Manage Project Views 

• Manage Task Views 

View managers can add any number of public filters to the view. The original view conditions appear, 
grayed, at the top of the conditions area. The filter you create builds upon these conditions. 
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You can add a public filter to an existing task view. 

1. In View Designer, on the Filters tab, click the New Filter  button. 

2. In the New Public Filter dialog box, type a name, add a description that appears as the ToolTip for 
the filter, and then click OK. 

3. To add the conditions that apply to the filter, but not the view, click the Add  button and then, in the 
Add Condition dialog box, do the following substeps: 

1. In the Constrain by list, click the view constraint to use. 

2. In the Type list, select the type of search to perform.  

3. In the Field list, select the field to use in the search. 

4. In the Operator list, select an operator to use when comparing the field and the value. 

5. If you are performing a LearnMode search, in the Plan list, select an application plan. 

6. In the Value box, select or type a value for the search. 

Note  If you selected Prompted in the Type list, the Message box appears instead. Enter 
instructions indicating what value to enter.  

7. Click OK. 

4. To add another condition to the filter, repeat the previous steps. 

Note  When you define a search with multiple conditions, each new row begins with AND by default. 
To change AND to OR, click AND. 

5. To preview the search results that will appear for the filter, in the Preview pane, click the Run  
button. 

Enable or disable the filter 
By default, when the view manager creates a public filter, the filter is enabled and available for all users 
who can access the view. You can disable the view if you plan to use it in the future. 

1. In View Designer, on the Filter tab, under Public Filters, right-click the filter and then click 
Properties. 

2. In the Modify Filter dialog box, do one of the following options: 

• To enable the public filter, select the Is active check box. 

• To disable the public filter, clear the Is active check box. 

3. Click OK and then save the view. 
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Customize the view column layout 
Preformatting the display of columns is an important advantage of ImageNow view definitions. This 
feature saves the user the time and effort required by manually adjusting columns each time the user 
opens a view. You define column formatting in the Preview pane of the View Designer window. You can 
perform these tasks directly in the Previews pane (by dragging or right-clicking column headings) or by 
clicking the Columns  button and making changes in the Columns dialog box.  

In addition to specifying column layout for each view definition, the view manager can define a separate 
column layout for each public filter of a view definition. Likewise, a user with the Filter privilege for a view 
can define a separate column layout in each private filter of that view. In the following procedures, you’ll 
learn how to show and hide columns, rename, resize, and rearrange columns, and add one or more 
custom property columns in document views and project views. You can customize the column layout for 
any document, project, or task view. 

The view manager can also sort columns in a view or public filter and group columns into collapsible 
nodes that group the search results automatically. You can sort the results by group. The following figure 
shows the view manager’s setup in the Preview pane for grouping invoices into Paid and Unpaid with the 
two groups expanded. 

 
  

Group Area 

Collapsible Node 
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You can also create multiple group levels. 

 

Select columns to display 
The view manager can determine which columns to display to any user who accesses the view. 

1. In View Designer, do one of the following options: 

• To select the columns to display in the view, select the View tab. 

• To select the columns to display in a public filter of the view, select the Filter tab and, under 
Public Filters, select the filter. 

2. In the Preview pane, click the Run   button to display the current column layout and click the 
Columns  button. 

3. In the Columns dialog box, select the check box of the columns you want to display and click OK. 

4. Click the Run   button to display the new column layout. 

Reorder view or filter columns 
After you add the columns to display in the view or public filter, you can determine the order of the 
columns. You can reorder the columns in a document, project, or task view or public filter. 

1. With the view or filter displayed in View designer, in the Preview pane, click the Columns  button. 

2. In the Columns dialog box, select the column you want to move and then click Move Up or Move 
Down. 

3. Repeat the previous steps for all columns you want to reorder. 

  

Group Areas 
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4. In the Columns dialog box, click OK. 

5. Click the Run   button to display the new column layout. 

Add a custom property column 
The view manager can add a column that displays a custom property value in a document or project view 
or in a public filter of a view. 

1. With the view or filter displayed in View designer, in the Preview pane, click the Columns  button. 

2. In the Columns dialog box, click the Add button. 

3. In the Custom Property dialog box, do the following substeps: 

1. To view the custom properties assigned to a specific document or project type, in the Select a 
document type or Select a project type list, select the type. 

2. Under Select a custom property, select the custom property column or columns you want to 
add. 

3. Click Add. 

4. Optional. To change the position of the custom property column, in the Columns dialog box, reorder 
the column. 

5. Click OK. 

Sort the view results 
The view manager can define the sort order of the columns that appear in the search results grid for a 
view or public filter.  

1. In View Designer, do one of the following options: 

• To define the sort order of the view, click the View tab. 

• To define the sort order of a public filter, click the Filter tab and select the filter. 

2. To sort by a single column, right-click the column heading and do one of the following options: 

• To sort the results in ascending order, select Sort Ascending. 

• To sort the results in descending order, select Sort Descending. 

3. To sort by multiple columns, do the following substeps: 

1. Click the column heading you want to use for the primary sort. 

2. Optional. To sort the primary column in ascending order, click the column heading again. 

3. Hold down the SHIFT key and click the heading of the column you want to use for the secondary 
sort. 

4. Optional. To sort the secondary column in ascending order, click the column heading again. 

4. Repeat the previous substeps for each additional column you want to sort by. 
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Group the view results 
The view manager can group the columns into collapsible nodes that appear in the search results grid for 
a view or public filter. 

1. In View Designer, do one of the following options: 

• To define the sort order of the view, click the View tab. 

• To define the sort order of a public filter, click the Filter tab and then select the filter. 

2. Right-click the heading of the column you want to group and select Group by this Column. 

3. To create additional groups, drag the heading of the column to the gray Group Area using the 
following options: 

• To create a group one level above the current group, drag the column heading to the left of the 
current group in the Group Area. 

• To create a group one level below the current group, drag the column heading to the right of the 
current group in the Group Area. 

Adding statistics to views 
For any view, a view manager can define statistics that provide calculations such as maximum, minimum, 
and average of all the values in a specific column in the view. For example, if an accounts payable 
administrator adds a sum statistic for a numeric custom property column that contains an invoice amount, 
the sum of all rows, which might be called "Total", appears below the search grid. 

As another example, you  might define a view to find unpaid invoices with discount dates that have not 
passed. Using a statistic, the view could display counts on the various discount percentages. The 
customer could use the information to determine whether to focus on a certain discount percentage or on 
the total of payment amounts.  

Statistic data types 
A view manager can add a statistic to a document, project, or task view or public filter. The following 
statistics are available for the specified data types. Count, which totals the number of documents, 
projects, or tasks that contain a specified text in the column you select, requires a variable. You can apply 
Count to a string, list, string custom property, or flag column. 

Column data type Statistic types 

string Count (not case sensitive) 

numeric Average, Maximum, Median, Minimum, Mode, Sum 

date Average date, Count Future, Count Past, Next, Previous, First, Last 

list Count (not case sensitive) 

flag Count 
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Add a statistic to a view or filter 
The view manager can add any number of statistics to a document, project, or task view or public filter of 
a view. By default, the statistics pane appears below the search results in ImageNow or WebNow 
Explorer, but can be modified to appear above the results. 

1. With the view or filter open in View Designer, in the Preview pane, click the Statistics  button. 

2. In the Statistics dialog box, do one of the following subprocedures. 

Add a statistic for a string value 
View managers can use this procedure to add a non-case-sensitive Count statistic that distinguishes 
string values, such as a task template or user name. 

1. In the Statistics dialog box, click Add. 

2. Under Label, type a label that describes the statistic function to appear in ImageNow or WebNow 
Explorer. 

3. Under Column, select the column with the string values. 

4. Under Function, select Count. 

5. Under Variable, type the value for the statistic. For example, if you want to count the number of 
search results where a custom property value is a vendor name, type the vendor name. 

6. Optional. Under Caption, type the text to display when the statistic applies to only one search result 
in the view. For example, if there is only one document in the search results list for the vendor 
specified in the Variable column, you can use the Caption column to show the document type of the 
search result to determine if it is an invoice or a purchase order. 

7. Click OK. 

Add a statistic for a numeric value 
View managers can use this procedure to display the average, sum, median, or mode statistic that 
distinguishes numeric values, such as the number of tasks or an amount custom property. You can also 
use numeric statistics to show the highest and lowest numeric value in the list. 

1. In the Statistics dialog box, click Add. 

2. Under Label, type a label that describes the statistic function to appear in ImageNow or WebNow 
Explorer. 

3. Under Column, select the column with the numeric values. 

4. Under Function, select one of the following options: 

• To display the average of all the numeric values, select Average. 

• To display the highest numeric value, select Maximum. 

• To display the lowest numeric value, select Minimum. 

• To display the total of all numeric values, select Sum. 

• To display the middle numeric value, select Median. 

• To display the most frequently occurring numeric value, select Mode. 

5. Optional. Under Caption, type the text to display when the statistic applies to only one search result 
in the view. For example, if one project has the most tasks in a Maximum statistic, you can use the 
caption column to show the project name. 

6. Click OK. 
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Add a statistic for a date value 
View managers can use this procedure to display the oldest, newest, or next date value in a list of search 
results or display the total number of dates in the past or dates in the future. 

1. In the Statistics dialog box, click Add. 

2. Under Label, type a label that describes the statistic function to appear in ImageNow or WebNow 
Explorer. 

3. Under Column, select the column with the date values. 

4. Under Function, select one of the following: 

• To display the total number of dates in the future, select Count Future. If no future dates exist, 
the statistic displays a value of N/A. 

• To display the total number of dates in the past, select Count Past. If no past dates exist, the 
statistic displays a value of N/A. 

• To display the oldest date value, select First. 

• To display the newest date value, select Last. 

• To display the next future date, select Next. If no future dates exist, the statistic displays a value 
of N/A. 

• To display the most recent date, select Previous. 

5. Optional. Under Caption, type the text to display when the statistic applies to only one search result 
in the view. For example, if you use a Next statistic to show the next task due for a project, you can 
use the Caption column to display the name of the project with the next task due. 

6. Click OK. 

Add a statistic for a list value 
View managers can use this procedure to add a statistic that distinguishes a unique value of a list custom 
property. 

1. In the Statistics dialog box, click Add. 

2. Under Label, type a label that describes the statistic function to appear in ImageNow or WebNow 
Explorer. 

3. Under Column, select the list custom property. 

4. Under Function, select Count. 

5. In the Variable list, select the list member value you want to use for the statistic. 

6. Optional. Under Caption, type the text to display when the statistic applies to only one search result 
in the view. For example, if there is only one document in the search results list for the list value 
specified in the Variable column, you can use the Caption column to show the name of the list 
member. 

7. Click OK. 

Add a statistic for a flag value 
View managers can use this procedure to add a statistic that distinguishes a true or false (boolean) 
condition. 

1. In the Statistics dialog box, click Add. 

2. Under Label, type a label that describes the statistic function to appear in ImageNow or WebNow 
Explorer. 
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3. Under Column, select the column with the boolean values. 

4. Under Function, select Count. 

5. Under Variable, select whether you want to count the results that meet the TRUE condition or the 
FALSE condition. 

6. Optional. Under Caption, type the text to display when the statistic applies to only one search result 
in the view. For example, if there is only one document in the search results list in workflow, you can 
use the Caption column to show the workflow queue the item is in. 

7. Click OK. 

Modify view statistics 
After you create all the statistics you want to appear in the statistics pane in ImageNow or WebNow 
Explorer, you can determine the order and position of the statistics. 

1. To preview the appearance of the statistics, in the Preview pane, click the Statistics  button. 

2. In the Statistics dialog box, click the row of the statistic you want to change and then do one of the 
following options: 

• To reorder the statistic, click Move Up or Move Down. 

• To remove the statistic, click Remove. 

3. Click OK. 

4. In the Preview pane, click the Run  button to display the statistics pane.  

Defining view and filter security 
After the view manager creates the view and customizes all the view components, he or she can grant 
user access to the view. Users and groups with access to the view see it in the Views pane of ImageNow 
or WebNow Explorer.  

View security definitions 
View managers define user and group privileges on the Security tab of the View Properties dialog box. 

Privilege Description 

Access The user or group can see the view. In addition, the user can use the Quick Search and 
Search tabs to narrow the number of results returned. A user can never access more 
results than the view allows. 

Access By 
URL 

The user can access the results of the view and its public filters using a WebNow or 
ImageNow link. A user can never access more results than the view allows. 

Filter The user or group can create and save private filters based on this view. 

Manage Lets the user manage the current view. This privilege also requires the associated global 
privilege for the view type. 

Grant access to a view 
1. In View Designer, in the toolbar, click the Properties  button. 

2. In the View Properties dialog box, on the Security tab, click Add. 
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3. In the Select Users and Groups dialog box, search for and select the users or groups you want to 
add to the view and then click OK. 

4. In the View Properties dialog box, under Users and Groups, select a user or group and then, under 
Privileges, grant a privilege by clicking in the column to the left of the privilege until the Granted  
icon appears, or deny a privilege by clicking in the same position until the Denied  icon appears. 

5. Repeat the previous step for each user or group you want to define. 

6. Click OK. 

Enabling the view in ImageNow and WebNow Explorer 
The view manager uses the Preview pane in View Designer to view the results of a view definition or 
public filter before making the view visible to users. When the view manager clicks the Run  button in 
the Preview pane, ImageNow returns the results that would appear to a user with Access privileges in 
ImageNow Explorer or WebNow Explorer if the view were activated at that time. This feature enables the 
view manager to remain in View Designer instead of using to the respective Explorer to check the 
accuracy of the definition. 

The view manager can also use a preview variable to simulate and the view results for a specific user or 
specific date when the view definition contains one or more variable type conditions. 

What is a preview variable? 
A preview variable is a value, such as a user name or date, that the view manager substitutes in the 
Preview pane to simulate the view or filter results. A preview variable can include the following options: 

• A user name different from the view manager’s 

• A date different from the current date 

Preview variables appear in the status bar at the bottom of the View Designer window as a reminder of 
the values the view manager substituted. For example, you can include a condition in a view or filter that 
tests for a user name, such as custom property field called Employee as a User data type, as shown in 
the following figure. 
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If the view manager runs the view or filter without a preview variable, the results are based on the view 
manager’s user name and the current date.  

Preview the view results with a variable 
The view manager can use this procedure to simulate the results of a view or public filter for another user 
or date. Preview variables are not saved with a view. 

1. On the View or Filter tab, verify or add a variable type condition. For more information on adding 
conditions to the view, refer to the “Define the conditions for the view” section of this document. 

2. In the Preview pane, click the Preview Variable  button. 

3. In the Preview Variables dialog box, do one or both of the following options: 

• To preview using a different date for the current date, under Date and Time, click the second 
button and enter the date and time. 

• To substitute a different user name for your own user name, under User, click the second button 
and enter the user name. 

4. Click OK. 

5. Click the Run  button to preview the view results using the variables. 

Activate the view 
Before any of your users can begin using the view, the view manager must activate and save the view. 
After the view is active, users can begin running the view in ImageNow and WebNow Explorer. 

1. In View Designer, on the View tab, click the Properties  button. 

2. In the View Properties dialog box, on the General tab, select the Is active check box and click OK. 

3. In View Designer, on the View tab, click the Save  button. 
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Views for ImageNow and WebNow client users 
All searches in ImageNow begin with a view or with one of the public or private filters displayed below a 
view.  

• Users and groups with the Access privilege for a document, project, or task view can run the view and 
its public filters in ImageNow or WebNow Explorer. 

• Users and groups assigned to a workflow process or queue can run the view associated with the 
process and queues. 

• Users and groups with the Access by URL privilege for a document, project, or task view can run the 
view and its filters from a WebNow or ImageNow link. 

• Users and groups with the Filter privilege for a document, project, or task view can create a filter in 
ImageNow or WebNow Explorer that is only visible to them. 

• Users and groups with the Manage privilege for a document, project, or task view are considered 
view managers for that specific view. 

In this section, you’ll learn how to search for document, projects, tasks, and workflow items using a view 
as a basis for your search and how to create private filters in ImageNow and WebNow Explorer. 

Using a view to search in ImageNow and WebNow 
The Views pane enables you to use a view or public filter as a basis for a search in ImageNow and 
WebNow Explorer. Using the Views pane, you can search for documents, projects, tasks, and workflow 
items. If the view returns the search results you want, you do not need to define additional search criteria 
in the right pane of ImageNow or WebNow Explorer. Ideally, your view manager creates views and public 
filters that eliminate the need for building advanced searches for frequent queries.  

Search for a document 
Users with access to a document view can search for a document using a quick selection or using 
multiple conditions. 

1. On the ImageNow or WebNow toolbar, select Documents. 

2. In ImageNow or WebNow Explorer, in the Views pane, select the document view you want to use 
as a basis for your search. 

• If you selected an automatic  view, the results are displayed immediately. 

• If you selected a manual run  view, you can perform a quick search or advanced search to 
narrow the results. 

3. In the right pane, do one of the following actions: 

• To perform a quick search 

1. Click the Quick Search tab. 

2. In the property list, select the custom property or document key to use. 

3. In the operator list, select an operator to use in the comparison. 

4. In the value box, select or type a value. 
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• To perform an advanced search 

1. Click the Search tab and do the following substeps: 

1. Click the Add    button. 

2. In the Add Condition dialog box, in the Constrain by list, click the document search 
constraint to use. 

3. In the Type list, select the type of search to perform.  

4. In the Field list, select the document field to use in the search. 

5. In the Operator list, select an operator to use when comparing the field and the value. 

6. If you are performing a LearnMode search, in the Plan list, select an application plan. 

7. In the Value box, select or type a value for the search. 

Note  If you selected Prompted in the Type list, the Message box appears instead. 
Enter instructions indicating what value to enter.  

8. Click OK. 

2. Optional. To add another search condition, repeat the previous substeps. 

4. Click the Go  button. 

If you need to create an advanced search with multiple conditions to obtain the search results you need, 
ask your view manager to create a view or public filter to simplify finding the documents you want. 

Search for a project 
Users with access to a project view can search for a project using a quick selection or using multiple 
conditions.  

1. On the ImageNow or WebNow toolbar, select Projects. 

2. In ImageNow or WebNow Explorer, in the Views pane, select the project view you want to use as a 
basis for your search. 

• If you selected an automatic  view, the results are displayed immediately. 

• If you selected a manual run  view, you can perform a quick search or advanced search to 
narrow the results. 

3. In the right pane, do one of the following actions: 

• To perform a quick search 

1. Click the Quick Search tab. 

2. In the property list, select the project property or custom property to use. 

3. In the operator list, select an operator to use in the comparison. 

4. In the value box, select or type a value. 

• To perform an advanced search 

1. Click the Search tab and then do the following substeps: 

1. Click the Add    button. 

2. In the Add Condition dialog box, in the Constrain by list, click the project search 
constraint to use. 

3. In the Type list, select the type of search to perform.  
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4. In the Field list, select the project field to use in the search. 

5. In the Operator list, select an operator to use when comparing the field and the value. 

6. If you are performing a LearnMode search, in the Plan list, select an application plan. 

7. In the Value box, select or type a value for the search. 

Note If you selected Prompted in the Type list, the Message box appears instead. Enter 
instructions indicating what value to enter.  

8. Click OK.  

2. Optional. To add another search condition, repeat the previous substeps. 

4. Click the Go  button. 

If you need to create an advanced search with multiple conditions to obtain the search results you need, 
ask your view manager to create a view or public filter to simplify finding the projects you want. 

Search for a task 
Users with access to task views can search for a task using a quick selection or using multiple conditions.  

1. On the ImageNow or WebNow toolbar, click Tasks. 

2. In ImageNow or WebNow Explorer, in the Views pane, select the task view you want to use as a 
basis for your search. 

• If you selected an automatic  view, the results are displayed immediately. 

• If you selected a manual run  view, you can perform a quick search or advanced search to 
narrow the results. 

3. In the right pane, do one of the following actions: 

• To perform a quick search 

1. Click the Quick Search tab. 

2. In the property list, select the property to use. 

3. In the operator list, select an operator, such as is equal to or is greater than to use in the 
comparison. 

4. In the value box, select or type a value. 

• To perform an advanced search 

1. Click the Search tab and then do the following substeps: 

1. Click the Add    button. 

2. In the Add Condition dialog box, in the Constrain by list, click the task search constraint 
to use. 

3. In the Type list, select the type of search to perform.  

4. In the Field list, select the task field to use in the search. 

5. In the Operator list, select an operator to use when comparing the field and the value. 

6. If you are performing a LearnMode search, in the Plan list, select an application plan. 
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7. In the Value box, select or type a value for the search. 

Note  If you selected Prompted in the Type list, the Message box appears instead. 
Enter instructions indicating what value to enter. 

8. Click OK. 

2. Optional. To add another search condition, repeat the previous substeps. 

4. Click the Go  button. 

If you need to create an advanced search with multiple conditions to obtain the search results you need, 
ask your view manager to create a public filter to simplify finding the tasks you want. 

Search for a workflow item 
Users with access to workflow process and queue views can search for an item using a quick selection or 
using multiple conditions. 

1. On the ImageNow or WebNow toolbar, select Workflow.  

2. In ImageNow or WebNow Explorer, in the Views pane, select the workflow process or queue view 
you want to use as a basis for your search. 

• If you selected an automatic  view, the results are displayed immediately. 

• If you selected a manual run  view, you can perform a quick search or advanced search to 
narrow the results. 

3. In the right pane, do one of the following actions: 

• To perform a quick search 

1. On the Quick Search tab, in the property list, select the workflow item property, document 
key, project property, or custom property to use. 

2. In the property list, select the property to use. 

3. In the operator list, select an operator to use in the comparison. 

4. In the value box, select or type a value. 

• To perform an advanced search 

1. Click the Search tab and do the following substeps: 

1. Click the Add    button. 

2. In the Add Condition dialog box, in the Constrain by list, click the workflow search 
constraint to use. 

3. In the Type list, select the type of search to perform.  

4. In the Field list, select the workflow field to use in the search. 

5. In the Operator list, select an operator to use when comparing the field and the value. 

6. If you are performing a LearnMode search, in the Plan list, select an application plan. 
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7. In the Value box, select or type a value for the search. 

Note  If you selected Prompted in the Type list, the Message box appears instead. 
Enter instructions indicating what value to enter.  

8. Click OK. 

2. Optional. To add another search condition, repeat the previous substeps. 

4. Click the Go  button. 

If you need to create an advanced search with multiple conditions to obtain the search results you need, 
you can create a private filter to simplify finding the workflow items you want. 

Using statistics in a view 
If the view or one of its public filters includes one or more statistics, you can use the statistics pane in 
ImageNow or WebNow Explorer after you run the view in any of the following ways. 

Action Procedure 

Highlight the search results that 
apply to a statistic 

In the statistics pane, click the Select in grid  button to the right of 
the statistic. 

Open a single document that 
applies to a statistic 

In the statistics pane, click the Open  button to the right of the 
statistic. 

Apply the statistic to a selection 
of search results 

Using the SHIFT key for continuous results or the CTRL key for 
discontinuous results, select the results in the grid. 

When the view or selection changes, the statistics recalculate automatically. For more information about 
creating statistics in a view, refer to the “Adding statistics to views” section in this document. 

Using private filters 
A filter lets you select a predefined subset of documents, projects, tasks, or workflow items returned by a 
view and simplifies the task of processing a large number of search results. As soon as you click a filter, 
ImageNow applies the filter to the view and displays the results in the grid. 

If you have the Filter privilege for the selected view, you can create as many private filters as you need. 
Unlike public filters, no other users can see your filters unless they have been granted the Manage 
privilege for the same view. The view manager can create public filters along with view definitions. If you 
want to share a private filter, the view manager can publish your filter as a public filter. 

Apply a filter  
You can use this procedure to apply a filter to a view in the Views pane of ImageNow or WebNow 
Explorer. 

1. In ImageNow or WebNow Explorer, in the Views pane, select a document, project, task, or workflow 
view to show its filters. 

2. Click the filter you want to apply to the view. 

3. If the Select a Search Value dialog box appears, select or type a value as instructed and click OK. 
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Create a private filter  
You can use this procedure to save a search you performed as a filter accessible to you in the Views 
pane of ImageNow or WebNow Explorer.  

1. In ImageNow or WebNow Explorer, in the Views pane, select the view you want to use as a basis for 
your filter. 

2. In the right pane, define your quick search or create conditions for an advanced search. For more 
information about creating a search, refer to one of the following sections in this document: 

• “Search for a document” 

• “Search for a project” 

• “Search for a task” 

• “Search for a workflow item” 

3. If the search returned the results you want, in the Current View toolbar, click the Save private filter  
  button. If not, refine your search and repeat this step. 

4. In the Save Filter dialog box, type a name and an optional description for the filter and click OK. 

After you save the private filter, it appears below the view you used to create it in the Views pane. 

Modify a private filter  
You can use this procedure to change the name and description of a saved search filter or the conditions 
associated with the filter.  

1. In ImageNow or WebNow Explorer, in the Views pane, select the view associated with the filter. 

2. To rename a filter or change its description, do the following substeps: 

1. In the Current View toolbar, click the Edit private filters   button. 

2. In the Edit Private Filters dialog box, select the filter and click Modify. 

3. In the Modify Filter dialog box, type your changes in the Name and Description boxes and click 
OK. 

4. In the Edit Private Filters dialog box, click Close. 

3. To change a condition in the filter, do the following substeps: 

1. In the Views pane, select the filter. 

2. On the Search tab, click the condition you want to change. 

3. In the Add Condition dialog box, modify the necessary components of the condition and click 
OK. 

4. In the Current View toolbar, click the Save private filter    button. 

5. When prompted to overwrite the original filter, click Yes. 

Publish a private filter 
A view manager can publish an existing private filter as a new public filter for the view. Only a user with 
the Manage privilege for the view can perform this procedure. 

1. On the ImageNow toolbar, click Manage. 

2. On the Management Console, in the left pane, click Views and, in the right pane, on the Document 
or Project tab, select the view definition that contains the private filter you want to publish. 
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3. Click Modify. 

4. On the Filter tab, expand Private Filters    and then open the private filters of the user who 
created the private filter. 

5. Under the user name selected, click the filter you want to publish. 

6. Click the Publish    button. 
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Reference 
This section contains information about views that you can reference when setting up and working with 
views. The following information is provided in this section: 

• View Designer toolbars 

• Current View toolbar 

• View privilege definitions 

View Designer toolbars 

View toolbar 

 

Tool Name Description 

 Save Lets you save changes to a view, which includes any of the filters for the view. 

 Properties 
Lets you activate or deactivate a view, grant view privileges to users and groups, 
specify the maximum number of rows that a view can display, and designate 
whether the view is run manually or automatically. 

Condition toolbar 

 

Tool Name Description 

 
Add 
condition Inserts a new row into the condition list of the view definition.  

 Cut 
Enabled if you have selected any conditions. Clicking Cut then removes the 
conditions and places them on the Clipboard. You select a condition by clicking to 
the left or right of the condition. 

 Copy Enabled if you have selected any conditions. Clicking Copy then places them on 
the Clipboard. 

 Paste Enabled if you have any conditions on the Clipboard. Clicking Paste then inserts 
them at the bottom of the condition list. 

 Delete Enabled if you have selected any conditions. Clicking Delete then removes the 
conditions without placing them on the Windows Clipboard. 

 Group 
Enabled if you have selected exactly two conditions. Clicking Group then removes 
the lower condition and adds it to the end of the upper condition with parentheses 
where appropriate.  
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Tool Name Description 

 Ungroup 
Enabled if you have selected a grouped condition. Clicking Ungroup then 
separates the grouped condition by removing the right most condition and 
inserting that condition in the row below the selected condition.  

 Move Up Enabled if you have selected a single condition below the top row. Clicking Move 
up then causes the selected condition to trade places with its upper neighbor. 

 
Move 
Down 

Enabled if you have selected a single condition above the bottom row. Clicking 
Move down then causes the selected condition to trade places with its lower 
neighbor. 

Filter toolbar 

 

Tool Name Description 

 Add Filter Adds a new filter definition to the selected view. 

 
Copy Filter 
From 

Enabled when you have a public filter selected. Clicking Copy Filter From lets you 
import a filter from another view. 

 Publish Enabled when you have a private filter selected. Clicking Publish changes that 
filter to a public filter. 

 Properties Enabled when you have a public filter selected. Clicking Properties lets you edit 
the filter name and description. 

 Delete Enabled when you have a public filter selected. Clicking Delete removes the filter 
from the view and from View Designer. 
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Preview toolbar 

 

Tool Name Description 

 Run Lets you display the result set of the current view or filter definition 

 
Preview 
variables 

Lets you substitute a different user, date, or time in place of the current user, date, 
and time, so that you can simulate run-time conditions to test the view or filter 
definition. 

 Columns Lets you define the layout of columns in which the result set is displayed. 

 Statistics Lets you manage the statistics that appear in the statistics pane below the search 
results. 

 Find Lets you search for a specific search result. 

Current View toolbar 
The Current View toolbar in ImageNow and WebNow Explorer enables you to work with the view you are 
running. 

 

Tool Name Description 

 Documents Display the selected document view. 

 Projects Display the selected project view. 

 Tasks Display the selected task view. 

 Workflow Display the selected workflow view. 

 
Save 
Private 
Filter 

Save the current conditions as a private filter. 

 
Edit Private 
Filters Open the selected filter for modifications. 

 Columns Display the Columns dialog box, which lets you customize the appearance of the 
columns in the grid. 

 Refresh Refresh the current view. 

 Find Display the Find bar, which lets you highlight character search results in the grid. 
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View privilege definitions 

Privilege Type Privilege Description Privilege Location 

Global 

Manage Document 
Views 

The user or group can 
create new document 
views and copy existing 
document views for 
which it has the Access 
privilege. The user or 
group can modify any 
document views for 
which the user or group 
has the Manage 
privilege. 

This privilege is located in 
ImageNow Management 
Console, on the Global 
Privileges tab, under 
Manage. 

Manage Project Views The user or group can 
create new project views 
and copy existing project 
views for which it has the 
Access privilege. The 
user or group can modify 
any project views for 
which the user or group 
has the Manage 
privilege. 

This privilege is located in 
ImageNow Management 
Console, on the Global 
Privileges tab, under 
Manage. 

Manage Task Views The user or group can 
define public filters and 
customize the column 
layout of a system task 
view for which the user or 
group has the Manage 
privilege. 

This privilege is located in 
ImageNow Management 
Console, on the Global 
Privileges tab, under 
Manage. 

View level 

Access  The user or group can 
see the view. In addition, 
the user can use the 
Quick Search and 
Search tabs to narrow 
the number of results 
returned. A user can 
never access more 
results than the view 
allows. 

This privilege is located in 
ImageNow View 
Designer, in the View 
Properties dialog box, on 
the Security tab. 
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Privilege Type Privilege Description Privilege Location 

Access by URL When displaying the view 
using a WebNow URL, 
the user or group can 
see the view and display 
its results and use the 
Quick Search and 
Search tabs to narrow 
the number of results 
returned. A user can 
never access more 
results than the view 
allows. 

This privilege is located in 
ImageNow View 
Designer, in the View 
Properties dialog box, on 
the Security tab. 

Filter The user or group can 
save private filters based 
on this view. 

This privilege is located in 
ImageNow View 
Designer, in the View 
Properties dialog box, on 
the Security tab. 

Manage The user can modify the 
view. This privilege 
requires the global 
privilege for the view 
type. 

This privilege is located in 
ImageNow View 
Designer, in the View 
Properties dialog box, on 
the Security tab. 
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